Summary

1 Installation and licensing...........................................................................................................3

2 Basic information.........................................................................................................................4
   2.1 Home screen ..........................................................................................................................4
   2.2 Base maps..............................................................................................................................6
   2.3 Cartographic properties ........................................................................................................6
   2.4 Terrain processing..................................................................................................................7
   2.5 Hydrographic network selection ............................................................................................8
   2.6 Gauging station data and hydrological information ...............................................................9
   2.7 Metrics of impacts and socio-environmental costs ............................................................12
   2.8 Unit price database ..............................................................................................................18
   2.9 Geological information analysis ..........................................................................................20

3 Potential sites identification........................................................................................................24
   3.1 Automatic hydraulic head search..........................................................................................24
   3.2 Identifying potential locations ..............................................................................................25
   3.3 Creating and/or deleting candidate sites .............................................................................26
   3.4 Simulating reservoir alternatives .......................................................................................28
   3.5 Reservoir properties and exporting results ..........................................................................36
   3.6 Editing sites and projects already created .........................................................................39

4 Engineering design....................................................................................................................40
   4.1 Reservoir operation analysis ...............................................................................................40
   4.2 Simulating project alternatives in batch mode ....................................................................44
   4.3 Engineering templates and layouts .....................................................................................45

5 Optimization...............................................................................................................................51
   5.1 Creating constraints for optimization ................................................................................51
   5.2 Running the optimization process ......................................................................................54
   5.3 Visualization and comparison of head partition alternatives .............................................55

6 Environmental impacts analysis................................................................................................59
   6.1 Integrated Environmental Assessment ...............................................................................59
   6.2 Socio-environmental sensitivity maps composition ............................................................62
   6.3 Environment impact maps composition ..............................................................................67

7 Realistic 3D Project Visualization.............................................................................................72

Annex A – Engineering module plugin..........................................................................................75
1 INSTALLATION AND LICENSING

HERA installer is available at PSR webpage (https://www.psr-inc.com). Unzip the downloaded folder and make sure to unblock the executable file (.exe) by right clicking it and checking Unblock in the General tab.

Right-click on the executable and Run as administrator. Installation begins with language setup.

Follow the instructions on the installation windows. HERA must have access to write files in the Example folder. If installed in a protected folder (ex: Program Files), please move the Example folder to another location with write permissions to guarantee the functioning of the test case.

When the installation is completed, the final window will have a checkbox to launch HERA. After launching it, it will be possible to open the example case that is available at PSR webpage and access the geoprocessing module.

HERA is free of use for nonprofit institutions under a special license. For private institutions, only the geoprocessing module is free of charge. To request a license, go to the HERA installation directory and run the PSRHostId.exe as an administrator. Then send the psrhardlockid.log file to hera@psr-inc.com and wait for our reply with a hera.lic file that will need to replace the existing file in the installation directory. After completing these steps, Engineering, Budgeting, and Optimizing modules become available.
2 BASIC INFORMATION

2.1 Home screen

HERA is a computational model for participatory planning studies concerning the development of hydroelectric projects. As soon as the application starts, the main screen displays the following menu of options.

The first three left icons are used, respectively, to create a new project, open an existing project, or close the current project. To create a project or select an existing one, browse the study data directory. These options are also available at the menu bar, inside the File tab.

The first option (New Project) requires the input of a Digital Elevation Model (DEM) or a Digital Terrain Model (DTM). This file must be in the TIFF or Tagged Image File Format (TIF) format, that are widely used in digital raster images in geographic applications (GeoTIFF).

Some examples of DEMs that can be obtained free of charge are SRTM¹, ALOS World 3D² and ASTER GDEM³. The Hydrosheds⁴ is also an important source of free global data, and the hydrologically conditioned digital elevation model can also be used⁵.

It is also possible to use more detailed elevation data in the HERA, from field surveys (aerial photogrammetry with cartographic restitution or radar survey, for example), or commercially available DTMs, which are usually more accurate than the public databases. Thus, the spatial resolution and the altimetric accuracy of the product used must be consistent with the objectives of the study that will be developed in the HERA. A preliminary hydropower assessment study, for instance, may use free database with low altimetric accuracy. The feasibility study of a specific project, in turn, will require a vertically precise DTM. It is important to emphasize this aspect: confidence level of the HERA’s result (outputs) is conditioned to confidence level of input data, including the DTM.

In this manual, the term DEM is used to refer to the elevation data file in general. HERA requires a single projected DEM file in tif format, with elevation data in meters. If several raster images exist, create a mosaic, clip to the desired study area, and apply a Projected Coordinate System with the GIS software / library of your preference. QGIS (https://qgis.org/en/site/) or R

¹ http://srtm.cgiar.org/
³ https://asterweb.jpl.nasa.gov/gdem.asp
⁴ https://hydrosheds.cr.usgs.gov/
⁵ https://hydrosheds.cr.usgs.gov/datasets.php
(https://www.rspatial.org/) are publicly available options to perform mentioned steps. A procedure to fill sinks in the surface raster is also recommended to remove imperfections in the data before importing it into HERA.

To start a new case, select the terrain file and an empty folder where the files that comprise a HERA case will be stored. It is important to note that HERA does not accept special characters when reading folder and file names.

HERA will then display the DEM with a color scale denoting elevation, as shown next.

Modifications made in HERA cases are saved automatically. To open an existing case, select the Open Project option.

The following table shows other useful options available in the main menu.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Pan icon]</td>
<td><em>Pan</em> — moves the map, for example, by manually centering the area of interest on the screen.</td>
</tr>
<tr>
<td>![Zoom In icon]</td>
<td><em>Zoom in</em> — zooms in on the marked area on the screen.</td>
</tr>
<tr>
<td>![Zoom Out icon]</td>
<td><em>Zoom Out</em> — move the marked area away from the screen.</td>
</tr>
</tbody>
</table>
2.2 Base maps

The base map can be switched to a satellite imagery (Google Satellite) or Google Maps from the View option of the main menu), as shown below.

For the selection of the Google Satellite option, for example, the map displayed is as follows:

2.3 Cartographic properties

The terrain properties are displayed in the main menu under Project> Project Properties. When there are accurate surveys or specific consolidated bases to the region of interest, the results of the studies will naturally be more assertive. When there are uncertainties in topographic data, as usual in public databases, the results of HERA studies should be interpreted as indicative rather than literal.

The screen shows the projection used, the size of the file with the terrain, the size of the cells according to the DEM definition. In the example below, SRTM was used – a free database of NASA topographic information with an accuracy of approximately 30 meters. On the same screen, the minimum and maximum elevations are also displayed.
2.4 Terrain processing

The next step is to process the terrain to extract the local hydrographic network with geoprocessing functions. This option is available under Project> Process Terrain.

A minimum drainage area is informed for the definition of the hydrographic network. This value depends on the scale and size of study area (e.g., small, medium, or large hydrographic basin). After generating the network, always check the result with the Satellite base layer and with hydrographic maps of the region. If some rivers / creeks of interest were not shown, repeat the process with a smaller value for the drainage area. On the other hand, if the network came out too detailed, consider using a larger value.

The definition of the hydrographic network requires high computational effort, and the execution time depends on the size of the basin (surface area). It can take some minutes for very large basins. As a reference, the next example used 50 km².
2.5 Hydrographic network selection

Next, select the rivers of interest in the hydrographic network using the Define study drainage network button.

After pressing this button, select the rivers of interest with the left mouse button. Be aware that the selected segments must be connected. To select several segments at once, right click at the most downstream segment and left click on Connect all upstream segments.

When all segments are selected, right click in any one of them, and choose Build study drainage network.

After a few seconds, the selected active network will be marked in red on the map.
2.6 Gauging station data and hydrological information

To input discharge data in HERA, use the Define inflow points button. Inflow points can be gauging stations, or potential dam sites where a time series of discharges have already been prepared with observed records from other sites. Click on the Define inflow points button and click at its location in the map. To remove an inflow point, right click on it and Delete.

To edit the discharge information, use the Define inflow points button, right click on the inflow point in the map and on Properties. Click on the Add line button to fill the start and final years of the record.

Monthly flows can be copied from an excel file and pasted on the table. On the left side of the table, paste the daily maximum flows of each year. HERA requires at least one complete year of monthly flows, and two values of maximum flows. Gaps are accepted, but the use of the longest treated historical record available is recommended.

The name of the inflow point can be entered in the upper field of the dialog box, as shown.

A shapefile with all inflow points can be imported at one time. Click File, Import inflow points, and select the shapefile in the Input, shapefiles folder. Remember that to import any shapefile, it must have the same projection as the elevation model, in this case, UTM zone 21 S.
To import series of discharges for several inflow points at once, import a csv file. With the inflow points (blue triangles) already located in the map, click File, Export historical flow series and browse to the selected folder to save the csv file. This csv file will have the flow points in the header row. Fill this file with the discharge series in the columns and the monthly values in the rows. The first column must contain the year and month with format YYYY/MM.

The file with the daily maximum flows contain the years in the first column, and the inflow points in the other columns. The discharge files of the case used for demonstration are available in the example folder ⁶.

After filling both files, click File, Import historical flow series, and browse to the folder where the files were saved.

To delete all inflow points from a case, click on the main menu bar in Project > Delete inflow points, as shown on the following left image. To delete an individual point, right click on the blue triangle and select Delete (as indicated in the image on the following right).

Once the inflow points and their discharge series have been defined, key hydrological characterization can be produced for any location in the hydrographic network by clicking at the indicated icon in this location.

---

⁶ For the example case, the location of the stations and the river discharge records were download from http://sirh.ideam.gov.co/Sirh/faces/observatorioSuperficiales.jspx
The image shows various information about the selected location. The upper left fields indicate: (a) the point coordinates; (b) the approximate elevation of the margins; (c) the drainage area of this site; (d) the water level of the mean flow at the selected site; (e) the average slope of the river in the studied section; (f) and other statistics, such as the average flow and the maximums for some recurrence times.

To estimate the water depth, HERA considers the Manning equation of free flow, with a coefficient of 0.030. It also assumes that river channel has a trapezoidal shape from the margins. For this calculation, the elevation data of the cell intersected by the vector representing the river is extracted from the DEM and considered the mean water level. The correspondent discharge for this water level is thus taken as the mean flow at this location. To calculate slope, a 1 km river section is considered, 500m downstream and 500m upstream.

In the upper right corner, the bar graph shows the historical mean monthly flows at the selected location. In the lower left corner, the river cross-section extracted from the DEM is displayed. Finally, the lower right corner shows the estimated rating curve for the site, which relates water level with river discharge. This curve is used to provide water level data for the design of hydraulic structures.

HERA has a feature that allows determining the catchment area of any selected location. It also possible to export its shapefile.
2.7 Metrics of impacts and socio-environmental costs

It is possible to import relevant information for the evaluation of the impacts of different hydropower development alternatives in hydrographic basins. These impacts can occur on infrastructure (e.g., roads, railways), on the environment (e.g., vegetation type flooded by reservoirs, impacts on species) or on social issues (e.g., displaced families). The starting point is to import the shapefiles for HERA analysis, which is obtained with the File > Create User Layer.

![File menu with Create User Layer option and shapefile browser](image)

From this menu, locate the desired shapefile on the computer, check if it must be copied to the case folder, select the type of Encoding (usually UTF-8) and name the layer for its identification in the map. In the figure below, the shapefile `population.shp` from the example folder is used.

By right-clicking the title of the selected layer in the left menu, functions may be used to change the layer symbology, edit the presentation style (for example by applying transparency to the layer for better visual communication), among other possibilities.

To present the Population layer one can choose a graduated classification. In the field column select which attribute will be used in the layer classification, such as the total number of inhabitants (Tot_inhab) or population density (Person_km2).

---


To create a metric, click the corresponding layer with the right mouse button, and then **Properties**. A description for the shapefile can be included with this option. The list of metrics will be presented right below this description. Click on the green plus sign to create a metric, on the pencil icon to edit it, and on the red minus sign to delete it.

A title for the metric and its unit must be informed. If **Consider reservoir buffer** option is checked, the intersections between the shapefiles of layers and the reservoir’s buffers will be accounted in the metrics. Go to Section 3.4 to see where to set the width of this buffer.

When creating the metric, the attribute of the shapefile that will be used in the calculation needs to be selected. The **Unit conversion factor** field is used to convert units of measure. The HERA length and area units are calculated by default in kilometers and square kilometers. If, for instance, area metrics are to be shown in hectares, the weight should be edited to 100.
There are three types of calculation methods: Values, Categories and Density.

- **Values:** the shapefile attribute has total values for each polygon.

Shapefile `population.shp`, available in the example folder, is used for this demonstration. Suppose there is a reservoir, that impacts four polygons (municipalities) and the selected attribute is the total number of inhabitants (Tot_inhab) per polygon. Note that the assigned attribute cannot have blank rows in the shapefile. All values must be filled with numbers.

In this case, it is necessary to calculate the proportion of the total population of each polygon affected by the reservoir. As mentioned, the weight can transform units. If it is desired to use the number of families as a unit for the displaced population instead of the number of people, with four people per family, the weight would be 0.25. Mathematically:

\[
M(R) = \sum_{i} w \cdot Atr(P_i) \cdot \frac{Int(R, P_i)}{Area(P_i)}
\]

*Where:*
- \( w \) = Unit conversion factor
- \( Atr \) = Attribute value
- \( Int \) = Intersection region in unit of area
- \( Area \) = Domain region in unit of area
- \( P \) = Polygon
- \( R \) = Project; \( i = 1, 2, 3 \ldots, n \)

<table>
<thead>
<tr>
<th></th>
<th>P1</th>
<th>P2</th>
<th>P3</th>
<th>P4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total area (km²)</td>
<td>0.361</td>
<td>0.117</td>
<td>0.418</td>
<td>0.0939</td>
</tr>
<tr>
<td>Total population (people)</td>
<td>259</td>
<td>2</td>
<td>5</td>
<td>1</td>
</tr>
<tr>
<td>Affected area (km²)</td>
<td>0.338</td>
<td>0.0447</td>
<td>0.350</td>
<td>0.0939</td>
</tr>
<tr>
<td>Affected population (people)</td>
<td>259 x 0.338 / 0.361 ~ 242</td>
<td>2 x 0.0447 / 0.117 ~ 2</td>
<td>5 x 0.350 / 0.418 ~ 5</td>
<td>1 x 0.0939 / 0.0939 ~ 1</td>
</tr>
</tbody>
</table>

Total number of affected people: \( 242 + 1 + 4 + 1 = 248 \) people.
It is important to note that for the Values method, independent polygons in the shapefile that contain the same attribute value must be displayed in different rows in the attribute table, that is, the merge tool should not be used in a geoprocessing software. If these different polygons are represented in the same row in the attribute table, HERA will consider the sum of the area of all polygons to calculate the proportional value of the attribute that is being affected by reservoirs. The figure below presents an example of the correct representation:

All polygons selected in blue have the same attribute value (11 inhabitants). However, each polygon is represented in a shapefile row. This is the correct representation.

To know which attribute should be indicated for the calculation of the metrics, it required to know the structure of the shapefile used in the creation of the layer. Shapefiles can be viewed in geoprocessing software such as QGIS (free) and ArcGIS. The data of the shapefile can also be opened in Excel by using .dbf file extension. In the example, notice the file named "population.dbf" that, once opened in Excel, displays the following information:
It is important to understand the shapefiles’ structure in its source (e.g., the meaning of the attributes) for the metrics to be created adequately.

- **Density**: the shapefile attribute has values per unit area for each polygon.

Following the example of the previously mentioned metric of values, in this case, the attributes of the polygons would be inhabitants per km² of area, and the respective attribute (Person_km2) should be chosen. Note that the assigned attribute cannot have blank rows in the shapefile. All values must be filled with a numeric character.

The operation is similar: the area intersections of the reservoir with the polygons is calculated by multiplying them directly by the value of the attributes of each polygon. Mathematically:

\[ M(R) = \sum_{i} w \cdot Atr(P_i) \cdot Int(R, P_i) \]

<table>
<thead>
<tr>
<th>Population density (inhabitant/km²)</th>
<th>P1</th>
<th>P2</th>
<th>P3</th>
<th>P4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Affected area (km²)</td>
<td>0.338</td>
<td>0.045</td>
<td>0.350</td>
<td>0.094</td>
</tr>
<tr>
<td>Displaced population</td>
<td>718 x 0.338 ~ 242</td>
<td>13 x 0.0447 ~ 1</td>
<td>13 x 0.350 = 4</td>
<td>14 x 0.0939 = 1</td>
</tr>
<tr>
<td>Total displaced population</td>
<td>242 + 1 + 4 + 1 = 248 people</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Categories**: the shapefile attribute has text values (categories) for each polygon. For each category, it is calculated the area affected by reservoirs which will be multiplied by the measure’s conversion factor. Mathematically:

\[ M(R) = \sum_{i} w(Atr(P_i)) \cdot Int(R, P_i) \]

To illustrate this method, the roads.shp shapefile from the example folder is used. The choice of method for calculating the metric depends on the type of information of the shapefile. When opened in Excel, roads.dbf file presents the information shown next.
As seen, there are both numeric and text attributes. However, the Values method will consider the values filled in the attribute column. If the length of roads intersected by reservoirs needs to be calculated, the categorized method with attribute “type” can be used, for example.

The option Break categories in individual metrics creates a separate metric for each type of road (bridleway, footway, etc.). If a single metric, considering all types of roads, is required, this option should be unchecked. If results are to be presented in meters, a 1000 factor is needed.

Generally, some of the impacts caused by hydropower development, captured by the metrics, can be converted into costs to integrate the plant’s budget. For example, if a candidate reservoir floods part of a road, that segment will have to be relocated. Similarly, if the reservoir interferes with a settlement, people will have to be relocated. In this way, the candidates with high impacts are correctly budgeted, considering the cost to mitigate these impacts.

To assign these costs, enable the Case settings, and go to Reservoir metrics costs in the left menu. Select the reservoir metric and the correspondent cost variable, according to the following table. Note that the unit cost must match the metric unit, that is, if the metric was
created in km², the cost must be informed in USD/km², and if the metric was created as total number of people, the cost must be informed in USD per person.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>bdg_res0_rurl_up</td>
<td>Rural properties affected by the reservoir</td>
</tr>
<tr>
<td>bdg_res0_urbn_up</td>
<td>Urban properties affected by the reservoir</td>
</tr>
<tr>
<td>bdg_res0_ppa0_up</td>
<td>Land purchase for conservation</td>
</tr>
<tr>
<td>bdg_relc_road_up</td>
<td>Roads to be relocated</td>
</tr>
<tr>
<td>bdg_relc_rail_up</td>
<td>Railways to be relocated</td>
</tr>
<tr>
<td>bdg_relc_brdg_up</td>
<td>Bridges to be relocated</td>
</tr>
<tr>
<td>bdg_res0_tlin_up</td>
<td>Transmission lines to be relocated</td>
</tr>
<tr>
<td>bdg_popl_rurl_up</td>
<td>Families affected by reservoir in rural areas</td>
</tr>
<tr>
<td>bdg_popl_urbn_up</td>
<td>Families affected by reservoir in urban areas</td>
</tr>
<tr>
<td>bdg_res0_clea_up</td>
<td>Vegetation removal before reservoir fill-up</td>
</tr>
</tbody>
</table>

### 2.8 Unit price database

The unit price database is used in the calculation of the budget of each project. To edit this database, click on the Engineering tab > Edit budget parameters. Unit values for various civil works can be modified in its Unit prices tab. It is possible to copy values from an Excel worksheet and paste them in HERA’s interface. Naturally, it is very important to adjust these values to the reality where the projects are planned. There may be substantial differences in unit prices across the countries or regions within the same country, for instance, related to access to the project site, production of materials, soil availability and others.
In the Environmental tab, the cost of relocating structures such as bridges, roads, railroads, and transmission lines is informed, in case they are impacted by the reservoirs. The costs of land, people resettlement and vegetation removal before reservoir fill-up are also given in this window.

Other costs can be informed in the Percentages tab. Their values are applied to specific sums of the budget accounts (for instance, following the table below, indirect cost for basic engineering will correspond to 4% of the total direct cost defined in the budget).
Equipment costs are defined in worksheets from the Brazilian Inventory Manual. Their charts present reference costs from December 2006 in Brazilian currency reais. Thus, necessary to update them to the reference date of the project and convert them to US dollars. The values presented next correspond to the exchange rate in December 2006 and the update rate for 2019.

2.9 Geological information analysis

In HERA it is possible to create sensitivity maps to provide an analysis of geological aspects related to the adequacy of the candidate sites through a geological point of view, concerning the construction of engineering structures (foundation, excavation, etc.) and the reservoir characteristics (risk of leakage).

At first, it is necessary to obtain a geological map of the interest area in shapefile format. Next, it is important to verify which field of the attribute table of the shapefile correspond to geological formations or lithology classifications.
Choosing the option to create a map for engineering structures, a window will open with a browse button to set the shapefile with geological information (“chronostratigraphic_units.shp”8, in the example) and a field to select the correct attribute (“Descripcio”, in the attribute table). This window has a dropdown to classify each attribute value as “good”, “average” or “poor”.

The classification used in this manual is just an example for demonstration purposes and should not be treated as a guide for other cases. In fact, in real cases, this classification must be done by a geologist or a geotechnical engineer.

After selecting all classes, click OK to see the geological sensitivity map for structures, that uses the risk color code: green for good, yellow for average and red for poor geology.

These results can be used to discard candidates in a preliminary analysis or to guide the classification of the rock quality in the properties table of each site (for more details about how it affects the engineering module, see section 3.3).

---

8 Source: https://www2.sgc.gov.co/ProgramasDeInvestigacion/Geociencias/Paginas/MGC.aspx.
A similar classification can be made for reservoirs but considering only two classes: good or poor. In this example, the same shapefile was used, with a similar classification, by simply changing the previous “average” classification to “poor”.
These results can also be used to discard candidates in a preliminary analysis or to create a metric that can be used as a restriction in the optimization studies (see item 3.1 to understand how it can be configured).

If the option to calculate reservoir geology attributes is made, HERA will write the percentage of poor geology for all reservoirs in the tab named “reservoir data” of the properties table of each site (see section 3.5 to visualize it).
3 POTENTIAL SITES IDENTIFICATION

3.1 Automatic hydraulic head search

HERA provides an automatic hydropower potential screening tool to be used in early stages of the planning process in a basin, when there is little knowledge about interesting locations for building dams. Parameters can be defined after clicking this button. Some are mandatory (Required Fields), others are optional (Search Filters).

The decision about the optional fields depends on the objectives of the search. For instance, if the interest is to find small hydro projects, a maximum hydropotential can be informed. Similarly, if the interest is to find rapids and waterfalls, a minimum slope and water head can be used. Another option provides answers related to potential sites for engineering layouts in which the powerhouse can be moved away from the dam. In this case, a maximum desired ratio between the distance between two points in a straight line and their distance along the river should be informed.

After pressing the OK button, a new layer is created with the segments connecting two points of the hydrographic network that fulfill the criteria selected before. It can be visualized in the lateral menu of HERA’s interface. Symbology can be modified to facilitate the identification of the segments. For instance, a palette of colors can be used to identify ranges of the Megawatt capacity of each segment. The shapefile can also be exported. In Properties, as seen below, the parameters selected in the search can be recovered. If there is no interest in maintaining a specific search result, its layer can be removed.
3.2 Identifying potential locations

The river longitudinal profile is also a valuable tool to identify potential locations for hydropower, especially rapids and natural falls. After enabling the tool on the upper main menu, use the left button to select a start and an end point for the river profile. Note that the selected river stretch must be hydraulically connected. After selecting it, it will appear on the map marked in blue. Right click on the blue stretch and choose Profile charts.

The elevation profile is presented in the red line, whereas the river discharges are presented in the blue one. The graph at the bottom of the screen provides the river slope. The slope peaks often indicate large concentrated natural hydraulic heads. In this screen, it is possible to create sites along the longitudinal profile (see how to do it in the next section). If there are already simulated sites on the map, they will also appear in the profile.

Other useful tools to this process are available on the main upper menu, being described in the sequence.

- The rule measure distances by clicking with the right button and creating a single segment, or a path. Use the left button to finish it.

- The **Elevation profile tool** traces the profile of the digital elevation model for the selected straight-line segments. Select the starting point and inflection points with the left button, and finish with the right button.
The contour line tool generates contour lines on the hypsometric map for a selected area, according to a selected interval, such as 5 meters. After enabling the tool in the upper menu, click a rectangle where the contour lines are to be displayed on the map. After drawing the rectangle and releasing the left button, select the desired interval.

![Elevation profile graph]

3.3 Creating and/or deleting candidate sites

There are different ways to create candidates for new hydroelectric plants:

(i) by choosing a location directly on the map.
(ii) through several points equally spaced vertically on a stretch of interest.
(iii) by choosing a location on the river profile.
(iv) by importing a shapefile with the points of interest.

It should be noted that it is only possible to create sites on active selected rivers (which appears in red color). This was described in Section 2.5.

To select a specific location in the map, enable the site manipulation tool in the main upper menu and left click in the desired location.

HERA will request the confirmation of the site creation, indicating its coordinates. After confirmation, a yellow dot will appear on the map, indicating the location of the candidate site.

![Create site dialog box]
The second option is enabled with the profile tool previously shown in item Section 3. After enabling this tool, select a start and end point on the active river network. The selected stretch will appear in light blue. Right click on the selected stretch and choose **Create sites**. Select the number of desired sites that will be equally spaced vertically (elevation).

The third option is also on the river profile tool. Right click on the selected stretch and choose **Profile charts**. While moving the cursor on the chart, a black vertical thin line can be seen. Position this line, for instance, after the beginning of a fall, left click and confirm. Click Ok to close the river profile window. Notice the yellow dot now shown on the map. Open the river Profile chart window again and notice the yellow dot also on the chart.

The fourth option is to import a shapefile to HERA with the coordinates of the sites, through the main menu, at **File > Import sites**. Browse to the folder that contains the shapefile. Note that it must have the same cartographic projection of the digital elevation model. This option may be interesting, for example, if a previous study was developed in the basin and the coordinates of candidate projects are known.
Location properties can be accessed using the Site manipulation tool by right-clicking at the site and then clicking **Properties**, or double left-clicking the yellow dot, always with the Site manipulation tool enabled.

As no reservoir has been simulated yet, site properties will only display general information, such as Site ID (identification code of each location), a name, the coordinates, the corresponding elevation in the elevation profile, and drainage area. Try editing the name field that will be exhibited on the map.

If there is information available about the site geology, it can be inserted in that window. The average thickness of the soil layer in the riverbanks and depth of the riverbed will be considered when calculating volumes. In the current HERA version, the rock quality classification will only impact HERA’s selection on the type of lining to be considered in the tunnels. However, other relations can be created in the engineering worksheets.

In this version, there is still no link between the geology information on the site properties screen and the geological sensitivity maps.

If there isn’t any information in that window, HERA will consider the rock quality as “poor”, a 3-meter soil thickness and a 3-meter riverbed depth.

To delete a candidate site, enable the **Site manipulation tool**, right click on the site, and Delete it.

All sites can be deleted at once with the option **Study > Delete Sites** of the menu bar. HERA will ask for confirmation before deletion.

### 3.4 Simulating reservoir alternatives

With the **Site manipulation tool** enabled, right click on the desired site and choose **Define hydro projects**.
HERA will then open the following window, let us call it the *hydraulic head creation window*.

This window has input data related to physical and energetic characteristics that will be used to design and simulate the candidate sites. It’s necessary to go through them one by one, but for now, let us skip the following options: *Delete existing non-selected hydro projects, Rebuild dam and reservoir of existing projects* and *Calculate flows*. Since they are used when reservoirs have been simulated, they will be explained in Section 3.6.

**Maximum acceptable dam length (m)**

This field allows limiting the maximum dam length according to local topographic characteristics. While designing the dam, HERA seeks the shorter segment that closes the abutments and creates the informed hydraulic heads. If it is not possible to create a reservoir for a certain head in a segment equal or shorter than the maximum acceptable dam length, HERA will not provide results for this head.

**Calculate reservoir metrics:**

HERA will only calculate user-defined metrics. Thus, intersections between the reservoir areas and user defined geographic data layers will be determined if this option is checked. For this, the metrics must have been created, according to Section 2.7.

**Default capacity factor**

The capacity factor is the ratio between the average electricity generation and the installed capacity. Generally, it is selected based on the annual variability of the hydrology regime and some measure of the opportunity cost of energy. An island that imports expensive diesel may design a hydro power plant to run with a lower capacity factor because for economic reasons.

Hydropower schemes often have significant flexibility in their design. For example, they can be designed to meet baseload demands, with an installed capacity low enough to ensure relatively high average capacity factors, but at the expense of being able to ramp up production to meet peak demand loads. Alternatively, a scheme could have relatively high installed capacity and low
capacity factor if designed to help meet peak demands and provide spinning reserve and or/other ancillary grid services.

The decision about which strategy to pursue for any given hydropower scheme is highly dependent on the local market, structure of the power generation pool, grid capacity/constraints, the value of providing grid services and others9.

Given a user-provided capacity factor, HERA’s algorithm determines the capacity to be installed through a binary search until the capacity factor calculated for the project meets the selected input. If the Default capacity factor is selected, it will be used in all plants, unless individual values for each site are provided in the table.

Starting and ending date for energy studies

This is the period to be considered in the energy studies. To calculate the installed capacity, for example, it can be used the complete discharge historical record, or a critical period of low flows. In the latter case, the energy produced is also known as firm energy.

Calculate projects cost

If this option is checked, HERA calculates the investment cost (budget) of the projects according to the method indicated in the selection box below.

The Simple Log Formula option applies a simple equation, which estimates the project investment cost from installed capacity and hydraulic gross heads. The Engineering model option is much more detailed (as seen in Section 4.3). It estimates the cost of civil structures using the unit price method. HERA’s engineering module calculates the total volumes and some detailed quantities for each structure according to the type of work to be performed (concrete work, reinforcements, excavations) and the total costs are obtained by multiplying the quantitative by the unit prices attributed to each item. A database of unit prices must be provided according to Section 2.8.

The Filter Sites option selects a subset of site locations. When clicking this button, a window with all available sites pops up (yellow dots) in the case. Desired sites can be selected by pressing the Ctrl key of the keyboard and the left button to choose multiple locations simultaneously. Right-clicking and dragging down can also be used to select multiple locations. Ctrl A selects all available locations.

The Single button is used to add a new reservoir alternative (new hydraulic head option) to the selected site(s). To use this button, first select the site at the left list of the window or use the Filter Sites button.

The **Multiple** button allows the creation of multiplehead alternatives in the same location.

The **Reservoir head** is the difference between the reservoir maximum water level and the terrain elevation at the dam site. The **Diversion head**, valid for diversion schemes\(^\text{10}\), is the difference between the terrain elevation at the dam site and the powerhouse. HERA will provide results for all possible combinations between the reservoir and diversion heads.

The red buttons on the right, highlighted in the following picture removes single head alternatives from the selection. This option does not delete the simulated candidates in the database, it only removes the head alternative from the hydraulic heads table, that is, it will not be simulated.

The **Select existing** and **Remove All** buttons are valid when candidate projects have already been simulated. **Select existing** adds to the table the alternatives previously built in those locations that are selected in the left window if there is an interest in editing them or retrieving them for

---

\(^{10}\) A hydropower plant scheme that has the powerhouse right downstream the dam is called “foot of dam”, or “toe of dam”. A diversion scheme is a type of hydropower plant in which water is diverted through tunnels or channels in order to take advantage of an elevation difference between the reservoir and the powerhouse, that can be located some kilometers downstream the dam, or even in another river or basin.
a new simulation. **Remove All** deletes all alternatives displayed on the table but does not delete them from the database.

The **Site ID**, the **Project ID** and the **Project name** are automatically defined by HERA in the *hydraulic heads table* (the following picture). The Site name can be edited but not in the following table (check Section 3.3 to see how to edit this name).

<table>
<thead>
<tr>
<th>Site ID</th>
<th>Site name</th>
<th>Project ID</th>
<th>Project name</th>
<th>Reservoir head (m)</th>
<th>Diversion head (m)</th>
<th>Restitution coord. X</th>
<th>Restitution coord. Y</th>
<th>Capacity factor (0 to 1)</th>
<th>Power (MW)</th>
<th>River transfer project ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Site 98</td>
<td></td>
<td></td>
<td>10</td>
<td>115.53</td>
<td>432202.99</td>
<td>361043.08</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Site 98</td>
<td></td>
<td></td>
<td>20</td>
<td>115.53</td>
<td>432202.99</td>
<td>361043.08</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Site 98</td>
<td></td>
<td></td>
<td>30</td>
<td>115.53</td>
<td>432202.99</td>
<td>361043.08</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Site 98</td>
<td></td>
<td></td>
<td>40</td>
<td>115.53</td>
<td>432202.99</td>
<td>361043.08</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Site 98</td>
<td></td>
<td></td>
<td>50</td>
<td>115.53</td>
<td>432202.99</td>
<td>361043.08</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Site 98</td>
<td></td>
<td></td>
<td>60</td>
<td>115.53</td>
<td>432202.99</td>
<td>361043.08</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Site 98</td>
<td></td>
<td></td>
<td>70</td>
<td>115.53</td>
<td>432202.99</td>
<td>361043.08</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

There are two ways of simulating diversion schemes in HERA. The first one is to directly fill the diversion head in the *hydraulic head creation window*. In that case there is no need to input the restitution coordinates, it will be automatically verified by HERA.

The second one, more precise, is to use the *Diversion scheme* tool. After enabling this tool, left click on the yellow dot that represents the dam site and make a second left click to place the powerhouse. Note that the second click must mandatorily be placed at a lower elevation than the first click. After the second click the *hydraulic head creation window* will automatically open, with the restitution coordinates and the diversion head already filled.

As already mentioned, there is a **Capacity factor** column in the *hydraulic heads table*. If this column is left blank, HERA will consider the **Default capacity factor**.

Instead of selecting a capacity factor, it is possible to define the installed capacity of each plant. In that case, HERA calculates the corresponding capacity factor as an output.
The River transfer project ID is the project ID number of the upstream reservoir from where water will be diverted in the cases of basin transposition. Let us use as example, the site 316 of our example case.

The previous example shows a basin diversion from Project ID 316 to a tributary where Project ID 543 is located (site 99). Therefore, when creating hydraulic heads for this site, it is necessary to indicate this site receives water from upstream Project ID 316 (as in the table below).

If the project design flows have already been determined by previous hydrology studies or the user wants to use criteria that are different from HERA default recurrences, the Engineering button can be used.

In the following window it is possible to input the flows used to design the spillway, the stilling basin, the river diversion – it is even possible to differentiate it in two phases – and the powerhouse deck protection. These values must be defined for each project ID, even if they
belong to the same site to test different criteria for comparison. Similarly, it is possible to inform an average inflow if a historical series is not available.

<table>
<thead>
<tr>
<th>Design flows</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Average inflow (m³/s)</strong></td>
</tr>
<tr>
<td>1</td>
</tr>
</tbody>
</table>

If these values are left blank, HERA will be calculated them automatically from the maximum flows of the stations using a 50-year recurrence time for the 2nd phase diversion, 100-year for the 1st phase diversion and the stilling basin, and 10000-year for the spillway and the powerhouse deck.

For each Project ID, HERA allows the definition of a buffer zone around the reservoir, as mentioned in Section 2.7, and the configuration of ecological flows in case of diversion schemes. Use the Environment button to open the following window and make these settings.

The buffer zone around the reservoir might be a requirement from the Environmental Agency, as a zone that the developer must keep protected as a conserved area. In addition, in some countries, the influence area of a reservoir includes a buffer zone around it, and the impacts on this zone must also be accounted, like the number of people to be resettled, or impacts on infrastructure, for example.

In case of diversion schemes with a large hydraulic circuit that creates a stretch of reduced flows in the natural course of the river, it is common to consider ecological flows. These flows will be deducted from the incoming flow to calculate the turbined discharge and, therefore, will not be considered in the installed capacity or in the electricity output of the plant.

After completing all the parameters of the hydraulic head creation window, click OK for HERA to start processing the alternatives.

If the alternatives are simulated with the Calculate projects costs option unchecked, HERA will only perform two functions for the projects listed in the hydraulic head creation table: find the smallest segment of dam axis for the site, considering each given head height, and try to generate
the respective reservoirs with their metrics. When the processing finishes, HERA presents a list with the simulated reservoirs, but if the site topography does not allow the creation of a reservoir within the maximum established dam length and inputted hydraulic head, HERA will display a message as shown below, and will not draw the reservoir.

![Hydro projects generation results](image)

As shown in the image below, the alternative displayed on the map can be selected by right-clicking on the yellow dot with the Site manipulation tool enabled, then on Selection, and finally on the desired drop combination. In this case, the value that follows U (from upstream) is the reservoir head, and the one after D (downstream) corresponds to the diversion head.

![Site manipulation tool](image)

On the map, the dam axis is shown in pink under the yellow dot; the reservoir, in blue; and the restitution location, in the case of a diversion scheme, is presented as the light blue dot.

![Map with reservoir and dam](image)

If the alternatives are simulated with the Calculate projects costs option checked, HERA will test all possible combinations of templates and layouts to calculate the plants’ budget. The templates and layouts will be addressed in detail on Section 4.3. When HERA can successfully estimate the budget for a tested layout, the total cost appears at the end of the line (see the second line in the example below). When the budget cannot be estimated, an error message
indicates the type of constraint or the cell in the dimensioning worksheet that prevents completion of the calculations (in the example, an undesired overlap between structures).

There are several reasons that prevent the budget estimation of some projects. Commonly, these cases are related to restrictions on the equations used in engineering worksheets or topographic characteristics, that can unviable, for example, the implementation of a diversion tunnel in very flat valleys. The log window also displays a summary of the combinations of templates and layouts selected for each processed head alternative, always corresponding to the design with the cheapest index cost. The log is also written in the LOG directory inside the case folder.

3.5 Reservoir properties and exporting results

Reservoir properties can be accessed with the Site manipulation tool by right-clicking and then clicking Properties, or double left-clicking the yellow dot.

The General tab presents the main energy properties and the cost of each head alternative. In the next example HERA is unable to find a valid combination of template/layout for the 40-meter head. All other budgets of that site were estimated successfully.

The table always shows a Project ID, project name (automatically generated by HERA) and the user-defined water head. HERA calculates the maximum turbine flow rate (m³/s), the annual production (GWh), the total capital cost (Million USD), the index cost (USD/kW), the water level and reservoir area. As mentioned earlier, if the capacity factor is given, HERA calculates the installed capacity and vice versa.

In the Reservoir data tab, the main characteristics of the reservoir are shown, as well as all the configured metrics.
Note that at this point candidates that perform poorly on a certain metric do not need to be removed. In a case with hundreds of candidates, doing this manually would be unfeasible. It is preferable to maintain all candidates and define social and environmental constraints in the optimization module (Section 5.1). Conflicting candidates (reservoir that would prevent the construction of another dam, or more than one head options in the same site) are also controlled by the optimization module.

In the Reservoir charts tab, the graphs of the area x water level and the volume x water level of the selected location can be visualized.
This button exports the content of the project to KML, that can be opened in Google Earth, as the example below. It can also be accessed through File > Export KML.

This button exports shapefiles with layers of information created by HERA, that can be used in geographic information software, such as QGIS or ArcGIS. It can also be accessed by File > Export data files. It is also possible to export CSV files with properties and metrics of candidate sites and cascade alternatives.
3.6 Editing sites and projects already created

The highlighted options below are useful when projects have already been simulated in a case and there is an interest in editing them.

**Delete existing non-selected hydro projects**

If this option is checked, the projects that are visible on this window’s table will be resimulated, and any existing projects that are not visible in the table will be removed from the database.

**Rebuild dam and reservoir of existing projects**

This option is used to rebuild the dam axes and their respective reservoirs. For example, if there is a case already executed with a 5000-meter *Maximum acceptable dam length (m)* that will be changed to 2000 meters. In this case, HERA needs to rebuild the dam axes, and this option **must be checked**, since just keeping existing projects in the table and maintaining the Project ID would only make HERA recalculate the energy parameters and budget, but it would not update the dam axis. Checking this option is also recommended when there is a new version of HERA.

**Calculate flows**

If discharge series of any station are modified, or new stations are inserted or removed, after the simulation of any reservoir, it is advisable to recalculate flows by keeping this option checked.

To permanently delete projects from the case database, select only the projects to be deleted on the *hydraulic head creation table*. Then click on this button.
4 ENGINEERING DESIGN

4.1 Reservoir operation analysis

This tool is used to simulate the reservoir operation. The simulation helps define the storage regulation capacity and the minimum operated flows supported by the reservoir. It will be also possible to check the effect of this operation in other energy-related parameters of the project, including its installed capacity.

Once the reservoir is selected, enter the period over for the simulation of reservoir operation. Only the inflows of this period will be used in the following calculations. The period is defined by a start month and an end month, by default, the same used in the initial energy simulation. Both must be entered in the format mm/yyyy and the period must be larger than one year.

After the initial processing, the following screen is displayed:

This window has seven main components, six charts and one control panel. This window represents the current hydroelectric project focusing on the possible reservoir operation modes. Some alterations of the project parameters can be simulated here. More specifically, it can simulate the actual energy production for any given installed capacity (or power) and useful volume (defined also by the minimum water elevation), either in terms of firm energy or average energy. The components are described as follows:
(1) Historical inflows

The blue line shows the average monthly inflows for each month of the given period. The orange line displays the expected inflow for each month, which is simply the average inflow for each month of the year in the given period. Note that the expected inflows repeat themselves every twelve months, providing an immediate visualization of drought and flooding periods. The horizontal dashed red line represents the current maximum turbinated inflow of the project. If compared to the historical inflows, it can be used to reassess the capacity factor of the plant.

(2) Elevation x area

This represents the reservoir surface area for each elevation. The horizontal dashed red line represents the current minimum water elevation of the project.

By clicking anywhere on this chart, the minimum water elevation can be changed and all charts depending on this value will be rebuilt. Note that this still will not change the project on the Hera database, instead it is done only for simulation purposes. To save these values to the real project, use a specific control panel option (item 7 described in the sequence).

(3) Energy x minimum water level

This chart simulates the energy production for each possible minimum water level. The horizontal red dashed line represents the current minimum water elevation of the project, which can also be changed in this chart by clicking anywhere on it, as in the previous chart.
The solid blue line represents the maximum firm energy that can be produced with each minimum water level. The firm energy here means the production that can be sustained every month in the given inflow period, considering all different values for the useful volume. In this example, it means that, if for a minimal (firm) monthly production of 60MW based on the entire inflow period, the reservoir needs to be operated to elevation 370m. If the project is designed to have a minimum water elevation above 370m, it will not be able to sustain 60MW.

The solid green line represents the maximum average energy that can be produced with the minimum water level. In this example, since this line is almost vertical, it means that the total production of this project will not suffer much if the minimum water level is too high.

The blue and green dashed lines represent respectively the firm energy and average energy when the operation focuses on maximizing the average energy or the firm energy. In other words, if the reservoir is operated to maximize the firm energy (solid blue line), the average energy is shown by the green dashed line. Likewise, if the operation mode is to maximize the average energy (solid green line), the corresponding firm energy is shown by the dashed blue line.

(4) Energy x minimum volume

This chart is analogous to the energy x minimum water level chart (item 3 above). The difference is that Y axis here represents the minimum volume of the reservoir instead of the minimum water level. The minimum volume can also be changed by clicking on this chart. By changing the minimum reservoir volume, the minimum water level changes accordingly.

(5) Installed capacity x energy

This chart illustrates the effects of changing the installed capacity or the maximum power of the hydroelectric project on energy production. The vertical red dashed line represents the current installed capacity and can be changed by clicking on the chart. Note that this still will not change the project on the Hera database, instead it is done only for simulation purposes. To save these values to the real project, use a specific control panel option (item 7 described below).

The meaning of the blue/green solid/dashed lines are the same as in the two previous charts. The case shows that the firm energy cannot be improved by increasing the installed capacity. This chart is built considering the current minimum water level (or minimum volume) defined by the red dashed line in the previous charts. Likewise, the previous charts are built considering
the installed capacity defined here. Whenever the minimum water level or the installed capacity changes, all associated charts will be rebuilt considering their new values.

(6) Firm energy x average energy

This chart displays the average energy for each value of the firm energy that the project is required to produce. The horizontal red dashed line shows the current average energy the project is supposed to produce. The average energy also defines the capacity factor of the project.

![Firm energy x average energy chart]

This last chart shows it is necessary to slightly reduce average energy (about 1MW) to maximize the firm energy. The current average energy and capacity factor can be changed by clicking anywhere on this chart.

(7) Control panel

This panel displays some fields of the parameters of the studied hydroelectric project. Only the installed capacity and useful volume are editable fields. Whenever new values are provided for these fields, click on “Update charts” to update charts considering the new values. Whenever any of the values displayed on the fields is changed by clicking on the charts, the fields are automatically updated.

![Control panel]

Power (MW) | 83.00
Turbined inflow (m³/s) | 247.40
Capacity factor (0 to 1) | 0.791
Estimated annual production (MW) | 55.65
Reservoir volume (km³) | 1109.79
Useful volume (km³) | 400.00
Maximum water level (m) | 275.00
Minimum water level (m) | 170.00

Update charts
Restore original parameters
Redefine parameters
The button “Restore original parameters” will restore the parameters of the project the moment this screen is initially displayed.

Every parameter changed on this screen has no effect in the real project stored in the Hera database unless the button “Redefine parameters” is clicked. Only then the changes are saved, and the project updated. Saving these new parameters may cause the engineering structures and project cost to be deleted, since it may no longer be compatible with the new parameters.

4.2 Simulating project alternatives in batch mode

The hydraulic head creation window shows the candidate projects that will be simulated after clicking OK. In the example below, three projects (i.e. three project alternatives with different heads) will be simulated for site 99. More projects can be added for the simulated on this table, or even all existing projects in the site, as described in item 3.4.

With this button is it possible to export the visible data from the hydraulic head creation window to a CSV file. This option is also interesting to save the data for future execution.

It is possible to export a CSV file with all simulated projects from the Study tab.

When importing the CSV file, the hydraulic head creation window will be filled with the information available in the CSV. After pressing OK, HERA will start executing the simulation of all visible projects on the table. The same option is available on Process hydro projects CSV file in the Study tab.
4.3 Engineering templates and layouts

As previously described, the cost estimates are obtained from the investigation of several engineering designs. This simulation can be made for one specific project, the complete group of site alternatives, or even for all the sites simultaneously, by checking the option Calculate projects cost in the hydraulic head creation window.

Another way to analyze design alternatives of each site is using the Engineering tool. By selecting this option, select any location (yellow dot) on the map, right-click on Build Engineering Models and open the following dialog box.

In this screen it is possible to generate all worksheets used by HERA workflow to size the engineering structures, as well as to calculate volumes and costs, for the head alternatives of a candidate site. It is also possible to restrict the simulation exclusively to a specific head alternative by selecting the corresponding reservoir on the interface map and marking Build only the visible project.

If some projects had already been simulated, their budgets will be recalculated (updated) after pressing OK click. Another exclusive option of this screen is the selection of a specific design from the available in the fields identified by Engineering template and Engineering layout. The templates are related to a set of structures (types of embankments, spillways, etc.), while the layouts refer to the relative position of these structures along the dam axis or, in case of diversion schemes, to the riverbank where the conveyance system will be built. The complete list of template and layout combinations is available in Annex A (Engineering module plugin).

Annex A further details the Excel worksheets of the engineering module, including variables coding criteria.
It is possible to use filters to discard projects with components that do not make sense for certain project conditions. For example, powerhouse solutions with Pelton turbines are not evaluated in low-head alternatives. Similarly, Bulb turbines are ignored for higher heads. With specialized knowledge, these filters can be manipulated in a specific spreadsheet located in the installation folder: C:\PSR\Hera\plugins\HydroPlantsCost\xls\hera_filter.xlsx (see more in Annex A).

Among the feasible solutions, HERA will naturally select the lowest index cost one. If another specific design is not selected, this will be the alternative to be considered by the optimization model, and hence the one presented not only in the site property table (in Properties, as described above) but also in HERA main screen map by a schematic drawing. This sketch includes definitive and temporary structures as well as approximate channel alignments.

In the case shown above, the template chosen for a 29 meter head alternative (U29D0) was PhKaps HsComp DmRock SpCbas DvRbed (powerhouse with Kaplan concrete turbine, compact hydraulic system, rockfill dam, controlled spillway with stilling basin and riverbed diversion without sluiceways), combined with the layout FtRbedLcfd SpLbed InLspw (plant at the foot of the dam, riverbed diversion with longitudinal cofferdam, spillway in the riverbed, to the left of the stream, and intake to the left of the spillway).

This information about the selected arrangement can be obtained at Engineering Models Properties > General.
In the previous screen, it is possible to generate and save the civil volumes and cost spreadsheets of the selected alternative using the buttons just below the description of the engineering design. It should be noted that part of the quantity calculations, specifically those that can be done by numerical integration, such as the ones done for dams and channels, are performed within HERA workflow. The quantity spreadsheet shows the calculations of the hydraulic structures that are not defined by the model and consolidates the information that serves as the input data for the budget spreadsheet.

As mentioned before, another way to generate spreadsheets, including sizing ones, is to check the Generate Excel files option on the Building engineering models screen, as shown below, for the desired hydraulic head alternatives (all or only the one that is visible in HERA’s interface), and the engineering design alternatives (all of them or some specific combination of template and layout). In this case, select a destination folder to save the files.

The files generated by HERA are Excel spreadsheets. They are named according to the simulated template and layout types as outlined in green in the example below. At the end of the file name, as highlighted in red, HERA identifies the type of structure whose characteristics can be verified in it. Filter files are always saved, including for the projects HERA has discarded, to become easier to identify where the values exceeded the limits of the acceptable range of characteristics.

The sample file above shows the results of a concrete dam sizing. When opening the file, notice the "iodam3" tab, with variables related to a rockfill dam. In this case, the values inside the tabs "iodam2" (earthfill dam) and "iodam1" (concrete dam) can be ignored. To visualize the values related to the earthfill dam, for example, generate all files of a template that has this type of structure.

As shown below, it is important to note that concerning the spillway, three different files were created for the its design.
In the file "... hera_spillway_iosp ...", which performs initial sizing of this structure, the tab to be verified depends on the type of the selected spillway (in the example, iosp4 corresponds to an uncontrolled spillway with dissipation basin). If the template includes this type of dissipation, which requires a specific iterative calculation procedure, its characteristics must be checked in the "iosb" tab of the "... hera_spillway_iosp" file. The ogee geometry of any spillway, in turn, is defined in the "iogeom" tab of the file "... hera_spillway_iogeom".

For output variables common to at least two of these files, according to the table below, the values defined are always placed in this order: "iogeom", "iosb" and "iosp4" (or any other dimensioning tab corresponding to the kind of spillway under study: iosp1, iosp2 or iosp3). This happens because the last step for these structures in HERA workflow is the design of the ogee geometry which adjusts the dimensions defined in previous steps. Likewise, the dissipation basin calculations made in the "iosb" spreadsheet replace the preliminary sizing of the “iosp4” spreadsheet. The following table shows an example of output variables calculated in “iosp4” and, after, adjusted by “iosb” and “iogeom” tabs.

<table>
<thead>
<tr>
<th>iogeom</th>
<th>iosb</th>
<th>iosp4</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In Engineering Models Properties > Spillway HERA shows a simplified representation of the spillway section. It is used by in the calculation of concrete and excavation volumes.
From this moment, it is possible to interact with the schematic drawing of the project on the map to show or hide structures or their axes from the options available in the menu on the left.

In the Engineering Tool it is also possible to delete the constructed models (Delete engineering models) and to export the necessary information to model the structures in REVIT (Export Revit CSV) - see Chapter 7.

Another tool available in HERA’s main toolbar that can assist in the analyses of the engineering designs is the Axis profile tool. With this tool, it is possible to visualize a chart with three lines along the axes of the structures and channels: the dam’s crest elevation (the dashed blue one), the terrain level (in red) and the top of the rock layer (in gray).

In the following example, the section under analysis, in yellow, corresponds to the segment of the concrete dam in the riverbed. The section to the side shows the horizons of soil and rock in relation to the crest of the dam. The average thicknesses of the soil layer are informed in the Properties table.
The engineering characteristics of the alternatives studied can be exported by generating a "CSV" extension file in the main menu under Engineering > Export Engineering Variables while selecting a folder to save it. In this same screen, it is possible to obtain both quantitative and cost worksheets for further comparison. Some filters can be used to select which projects that should be saved: the set of plants of a known partition, the set of plants showed in HERA map or only the plants with a budget successfully calculated.
5 OPTIMIZATION

5.1 Creating constraints for optimization

After simulating candidate sites, it is possible to define restrictions for the inventory studies. Enable the Site manipulation tool and right click on the desired site.

Generally, candidate sites are considered optional construction, that is, the optimization module will select the candidates that maximize the net revenue from electricity sales, under the provided environmental and social constraints.

If there is an existing plant, it will be possible to select the corresponding option, but it will be only available if the site has only one simulated project (reservoir).

It is also possible to force the construction of a project (e.g. if the decision for developing it has already been made) or cancel it.

The socio-environmental constraints can be configured with the Case settings tool.

The Attribute sum constraints can be applied to the reservoir metrics that are cumulative, that is, the total value of a head partition is the sum of metric’s values of each reservoir included in that partition. This type of constraint is generally applied to the metrics measured in area or length units, and to the metric related to population relocation.

In the example case, constraints prevent reservoirs from being built in areas covered by Paramos, dry forest and protected areas. All candidates that impact those areas will therefore be discarded for optimization.

A constraint was added to limit the length of roads flooded by the reservoirs to 50 km at most.
In HERA, mathematical modeling was extended to define constraints of this type, considering that if a hydroelectric plant is built in a river stem, all upstream stretches are fragmented. Thus, migratory fish from the mouth would be able to swim freely to the plant, but not upstream of it. These "topological" constraints are switched on/off with logical variables related, of course, to the binary variables that control the construction of candidate projects.

The Connected stream constraints option allows the user to calculate the total length of rivers left "free of dams". The following picture illustrates two alternatives of hydropower development in a basin, with similar capacity, but with different river fragmentation.

Reference scenario and two others of hydroelectric development with similar generation, but different levels of fragmentation: scenario B is less fragmented than A. Source: The Power of Rivers\textsuperscript{1}.

Note that the connectivity (or its contrary, fragmentation) is a metric valid for partition alternatives (sets of candidate hydro plants, or in other words, different scenarios of hydropower development). Hydro plants in an alternative change the connectivity metric.

In our example case, the Saldaña river is a tributary of the Magdalena river, which flows to the ocean. In that case, it is necessary to inform the coordinates at that mouth of the Saldaña river. The best way to get the coordinates is to create a temporary candidate site at the river mouth just to get more accurate values for \( x \) and \( y \). If you want to restrict the river fragmentation, you can specify a bound, so that river connectivity will be equal or larger than the informed bound.

To complement the database required for the fragmentation study, the natural barriers in the basin, such as waterfalls, should be informed. This type of information is inserted as a

geographic layer through the Create User Layer option. It should have a shapefile of points representing waterfalls (these points must intercept the drainage network). After creating the layer, select it from the window below by moving the layer of interest from left to right.

Besides “additive” and “topological” constraints, HERA was extended to model a satisfaction function of established metrics. The logic is that a metric is evaluated with this function, with values ranging from 1 (full satisfaction) to 0 (no satisfaction). Suppose a biome, in which the maximum acceptable area that could be impacted by reservoirs ($\overline{A}_j$) is known. In addition, suppose that $\overline{A}_i$ is a threshold area for reservoir interference without bringing any threat to the biome. If the impact of the dams and reservoirs on this biome is below $\overline{A}_i$, the satisfaction function assumes the unit value. If the impact is between $\overline{A}_i$ and $\overline{A}_j$, satisfaction decreases from 1 to 0. For impacted areas higher than $\overline{A}_j$ the satisfaction function is null.

This approach allows optimization with a set of minimum satisfaction constraints. Alternatively, more broadly, it is possible to assemble a constraint that combines the satisfaction of a weighted average satisfaction with $\lambda$ the minimum satisfaction, weighted $(1-\lambda)$. More specifically, the constraint takes the form:

$$\lambda \cdot S_{avg} + (1-\lambda) \cdot S_{min} > S^*, \text{ where:}$$

$$S_{min} = \min \{S_1, S_2, S_3, \ldots, S_j\}$$

$$S_{avg} = \frac{(w_1 \cdot S_1 + w_2 \cdot S_2 + \ldots + w_j \cdot S_j)}{J}$$

At the top of the dialog box, the values of a satisfaction bound ($S^*$) and the relative weight of the average value ($\lambda$) should be reported. In the lower part, on the other hand, the specific
constraints of each reservoir metric created for the project, the minimum and maximum acceptable values, and the weight attributed specifically to the metric (w) must be given.

All types of constraints are written in files to the optimizer.

5.2 Running the optimization process

To run the optimization process, go to Optimization tab and choose Optimize partition alternative.

In the General tab of the Optimization window, browse to the folder where the files will be written. Next, name the partition that will be created.

The Parameters tab has several economic inputs, such as the price paid to the hydropower production. It is generally related to the long-term marginal cost of electricity in the market.

The annuity is the capital cost of a plant (CAPEX) distributed in equal payments, made in equal time steps during the useful life (n) of the power plants, as illustrated in the following picture. The discount rate (r) refers to the interest rate used in discounted cash flow analysis to determine the present value of future cash flows. Annuity is given by:

\[
Annuity = \frac{r \cdot CAPEX \cdot (1 + r)^n}{(1 + r) \cdot (1 - (1 + r)^n)}
\]
HERA’s objective function is to maximize the economic benefit of the portfolio of selected projects given by the net difference between energy sales revenues and construction and operative costs\(^\text{12}\) subject to physical constraints, such as the water balance in each dam, and environmental constraints, such as maximum flooded area. The relative convergence tolerance (\%) is the error gap, a measure of the convergence to the optimum solution, that is, how far the solution is from the optimum. The minimum total outflow penalty is the penalty “paid” for not meeting the ecological flows constraints.

Inflow variability is also considered in the problem through future inflow scenarios based on the historical records. In the Scenarios tab, it is necessary to indicate the desired number of scenarios, that will be based on defined years from the historical record, and a correspondent probability.

When done filling all tabs, click on Generate optimizer files to write the files without running the optimization or click Execute optimizer to run it immediately. When the optimizer starts running, a log window appears. As seen, all projects that did not have their budgets calculated are ignored.

The optimum selected portfolio is written in a file named outpdec.csv. Intermediate solutions are written in files with the characters \(\text{_y2099f}\) after the outpdec prefix in their name. In the example case, seventeen intermediate solutions were generated.

5.3 Visualization and comparison of head partition alternatives

It is possible to import the optimizer output files (outpdec.csv), at Optimization > Import Optimizer Results and select the outpdec.csv files containing the selected projects.

The Manage partition alternatives tool lets the user edit and save head partition alternatives. When creating a new alternative, the head partition will be formed by the set of reservoirs that are visible in HERA’s graphic interface. In the following window is possible to view and rename the head partition alternatives.

\(^{12}\) In a simplified form:

\[\text{Annual gross revenue} = \text{Annual generation (MWh)} \times \text{Energy price (USD/MWh)}\]

\[\text{Annual net revenue} = \text{Annual gross revenue} - \text{Annuity}\]
To manually create a partition, turn on the reservoirs that will be part of the portfolio, open the Manage partition alternatives and click Create new partition from map. To change the partition being presented in the map, click Load partition to map. To edit an existing partition, turn on the projects that will be part of the portfolio, open the Manage partition alternatives and click on Save map to partition. Finally, copy and/or delete existing partitions with the last two buttons.

In the example case, the Selected portfolio partition was copied and named P18 manual. In this partition site 94 was removed to compare metrics.

The Partition Alternatives Properties compares attributes of interest for different alternatives, such as the installed capacity or the total investment cost, in addition to the metrics defined for the reservoirs.

These two tools can also be accessed in the main menu bar, in Study, as indicated below.
It is possible to create a complete web viewer with hydropower development partitions (or scenarios) can be loaded.

On the **Edit Metrics** tab, edit the label that will be visible on a parallel axis plot containing the metrics, preferably using an abbreviation for its name. Select **invert axis** for the metrics with lower values in the upper part of the plot (for example number of people affected, the smaller, the better). It is also possible to edit the title, that will appear when placing the cursor on the metric label. The **Preselect** option is used to configure which metrics are visible when the page is opened. The metrics that are not checked will be available to be added in the viewer, with a specific button. Group colors can be selected for the metrics’ labels or edit the group’s name. Finally, edit a description for each metric.

In the **Edit Layers** tab, the user can configure the label, color, and opacity of all the user layers in the case.
After finishing the configurations, select a folder to export the viewer files, and click OK. Then, click in Partition analysis > Open viewer. Select the folder with the viewer files, click OK, Open viewer server, and the viewer will automatically open in the browser.
6 ENVIRONMENTAL IMPACTS ANALYSIS

Inventory Studies and Integrated Environmental Assessments (IEA) have the combined objective of analyzing river basins, with complementary objectives. While Inventory Studies focus on comparing and selecting options for harnessing the hydroelectric potential of river basins, the IEA evaluates the capacity of natural and human environments to host the selected group of hydropower projects.

The IEA results are meant to be discussed by stakeholders when deciding for the best alternative. Guidelines and recommendations become inputs to the feasibility studies and the environmental licensing process. Additional objectives include:

- Sustainability indicators for the river basin, focusing on water resources & hydropower.
- Identification of fragile areas and socioeconomic potentialities that could be leveraged by the construction of hydropower projects.
- Identification of conflicts over different uses of land and water resources within the river basin.

HERA’s environmental plugin provides access to the IEA methodology\(^\text{13}\) in the context of hydropower planning. The IEA is quite flexible because it needs to adapt to different regions and analysis criteria. For this reason, HERA’s IEA plug-in provides algorithms for generating environmental impact maps that are decoupled from HERA’s “core” functionality and database. These algorithms act on external, user-provided maps in shapefile (.shp) and raster (.tif) formats. It is up to the user to organize and name the various intermediate files produced by the algorithms. At the end of the process, environmental impact maps are added to HERA as new layers of information. The calculation of impact metrics from these layers follows the same procedure as any other user-provided layer.

6.1 Integrated Environmental Assessment

As proposed by the methodology, promising selected hydropower alternatives (scenarios) can be evaluated to highlight the cumulative and synergistic impacts caused by the set of plants. The analysis of the environmental system requires the consideration of its physical-biotic, social, cultural, economic, and political processes, as well as its interrelations (including geographical), which require a multidisciplinary approach.

To represent this system, an analytical structure based on three components was adopted, here called “synthesis components”: Aquatic Ecosystems / water resources, Terrestrial Ecosystems, and Socio-Economy (ways of life, spatial organization, economy, and traditional populations). These components are structured based on relationships between various elements of the environmental system. These maps should be prepared by a team of consultants in a shapefile format (*.shp) and imported to HERA’s database.

\(^{13}\) http://www.epe.gov.br/pt/publicacoes-dados-abertos/publicacoes/avaliacao-ambiental-integrada-aai
The environmental sensitivity maps are presented with the purpose of identifying and spatializing the most sensitive areas of the hydrographic basin, in order to express the degree of integrity of natural resources, the qualitative aspects of the landscape and the different socioeconomic situations in different degrees of sensitivity.

The IEA module provides flexibility for weighting the sensitivity indicators and obtaining results almost instantaneously, which greatly facilitates discussions by the various stakeholders.

IEA also identifies socio-environmental impacts of hydropower development scenarios. These impacts are used to compare and select the scenarios. They highlight the main socio-environmental issues related to the development of the projects through indicators of the synthesis component. The methodology proposes: (a) the identification of impacts; (b) their intensity (or weight) and (c) spatial scope, with emphasis on cumulative and synergistic effects.

The classification and weighting of impacts and their spatial scope allow the elaboration of maps of these impact indicators and the definition of most fragile regions for hydro development.

These matrices are part of the impact module and allow the user to identify the impacts, their intensity and coverage area. Any changes in the graduation or weighting of impacts can be made directly in the impact matrix. HERA module will consider changes when producing impact and environmental fragility maps.

At the end of the process, the environmental impacts and fragility maps, built taking into consideration the construction of the plants, can be imported into the Hera database in the form of "user layers" and then used in the calculation of impact metrics.

The first step in the development of the IEA is the generation of environmental sensitivity maps from the databases and maps obtained in the diagnostic phase. This diagnosis is focused on three discussed synthesis components: (i) water resources and aquatic ecosystems (ii) terrestrial and physical ecosystems, (iii) and socio-economy. The variables and mappings that make up each of these sensitivity maps must be prepared and imported to HERA in shape-file format. For example, the water resources and aquatic ecosystems environmental sensitivity map can be built by spatially weighting the map layers of water quality indicators and aquatic habitats or ecosystems indicators. In this proposed methodology, this term is being used in order to identify and spatialize the most sensitive areas of the hydrographic basin, in order to express the integrity of natural resources, the qualitative aspects of the landscape and the different socioeconomic situations in different degrees of sensitivity.
The IEA features a basic algorithm consists in spatial joining (union) a set of input thematic map layers, each one representing an environmental sensitivity indicator, to produce a thematic map layer as an output. As shown next, a different weight can be assigned to each input layer to differentiate the relative importance of this layer to the result.

The resulting layers is a shapefile of polygons with an attribute called "total" with the sum \( V_1 W_1 + V_2 W_2 + \ldots + V_n W_n \), where \( V_i \) is the value of the attribute in layer \( i \) and \( W_i \) its weight. In areas not covered by a given layer, the assumed value is equal to zero.

The next figure illustrates an example of joining two layers with a same weight (\( W_1 = W_2 = 0.5 \)). The first layer, in blue, has two polygons with the values two and five. The second layer, in red, has only one polygon with a value of three. The union of the two layers results in a layer with five polygons, each one with a value given by the average of the corresponding value of the two original layers. For regions where there is no value defined for one of the layers, the algorithm assumes a value of zero.

![Example of joining two simple layers.](image)

The IEA HERA module allows the use of an unlimited number of thematic layers (maps), based on the available georeferenced database, and elaborated in the diagnosis stage. Each sensitivity map has an attribute that represents the degree of sensitivity of each geographical region covered by the map, for example, areas with rapids have a high degree of relevance to the ichthyofauna,
as well as areas of good water quality. The resulting map of the selected indicator for each synthesis component is a combination of the degree of sensitivity of each thematic map, considering the weights assigned to each of them.

6.2 Socio-environmental sensitivity maps composition

To illustrate, the composition of the sensitivity maps, the information and georeferenced data for the Rio Branco basin were selected, which were the result of the last IEA report approved by EPE – the Brazilian Energy Planning Agency. For this purpose, water quality and aquatic ecosystem mappings will be used.

The first step consists in importing to HERA the water quality and aquatic ecosystems thematic map layer, using the Create user layers feature as illustrated by the figure below:
When importing a thematic map in HERA, the polygons that make up the map are initially displayed in a single color. In thematic maps that represents a phenomenon as a scale of numerical values, as is the case of sensitivity indicator maps, ideally a symbol that associates each level of sensitivity to a color, in a color scale, should be used. This allows the visual analysis of different levels of sensitivity areas. The symbology of a thematic map layer can be configured by right-clicking on the layer and selecting the menu option *Symbology* from the context menu:

**Definition of symbology, number of classes and grading of the water quality map**
The same steps should be followed when importing and configuring the symbology of the thematic map layer that represents the aquatic ecosystems to produce the aquatic ecosystem indicator map.
Once the thematic map layers have been imported into HERA, the next step consists in creating the Water Resources and Aquatic Ecosystems (WREA) sensitivity map by spatial joining the selected map layers, considering their respective weight. The first step to compose this map is to perform the weighted spatial join of the water quality and aquatic ecosystems thematic map layers, by using the Join layers feature, available from the IEA of the Environment menu. For each selected input map layer, provide the weight (%), that the layer will have on the resulting weighted map generated by HERA. In the example below, a weight of 70% was chosen for the water quality indicator and 30% for aquatic ecosystems.
Once the join process has finished, the WRAE sensibility indicator map layer needs to be imported into HERA with the *Create user layers* feature. Afterwards, the map symbology can be configured to represent the different sensitivity levels in a color ramp.

The tools and procedures available allow changing the variables grading and weighting of the layers in an agile way, with automatic responses that facilitate meetings and discussions among the various stakeholders as part of the approval of the inventory studies.

As an example, the following WRAE map was created with the same input layers, but different weights (water quality indicator with 30% and ecosystems with 70%).
6.3 Environment impact maps composition

The impact indicator is the instrument that guides the assessment of the negative socioeconomic effects of one or more power plants on a synthesis component, determining the focus of the analysis. The impact indicator is constructed from the generic identification of the main impacting processes, organizing the data in the form of assessment elements. These keep correspondence with the elements arising from the diagnosis stage. IEA should focus on the cumulative and synergistic effects of the set of hydroelectric projects proposed for the river basin. In the example below, existing alternatives are selected for the AAI methodology.

Using the Branco River basin as an example, the impact indicator maps for each synthesis component will be composed of (i) water resources and aquatic ecosystems, (ii) terrestrial ecosystems (TE) and (iii) socioeconomics (SE).

The first step for building the impact maps, consists in populating the impacts matrix file. The impacts matrix is organized by synthesis components and shows the common elements in an impact assessment that can be easily filled out by specialists in each of these areas of knowledge.
Each of the synthesis components has an associated list of impacts that can be changed. These changes should focus on cumulative and synergistic impacts. Therefore, changes in impacts of a permanent nature should be prioritized since temporary impacts reduce cumulativeness.

Selected hydroelectric power plants in the Rio Branco river basin

The matrix is populated by using the Write impact matrix functionality, available under the Environment / integrated environmental analysis menu. When accessing this functionality, HERA displays a dialog box with a list of scenarios for hydropower development in the basin. Any subset of alternatives can be considered. In this way, it is possible to evaluate alternatives, and not just the one considered to be the best, from a technical-economic point of view—the actual practice. This is fundamental to widen the discussion with the various stakeholders, allowing them to actively participate in the process.
HERA accesses the data of the hydroelectric plants for the preparation of the impact indicator maps for each synthesis component, considering its scope and variables that define its weight, such as the average flow and reservoir storage, related to “water residence time”.

Impact matrix results for three power plants: s4p7, s6p10 and s2p15

With these results, it is possible to access the build impact map functionality to create the impact indicator maps. At the end of the processing, 3 indicator maps are created: (i) water resources
and aquatic ecosystems (WRAE), (ii) socio-economic and (iii) terrestrial ecosystems. These maps can then be imported to HERA’s workspace, with the Create user layer functionality.

Making impact maps.

Incorporation of the WRAE impact indicator map into the HERA work area and preparation of the maps

After the incorporation of the impact maps in HERA, the symbology configuration can be changed by using the Symbology option, as shown by the picture below, where the color ramp and the number of impact classes are defined.
Once symbology is defined, socioenvironmental impact indicators maps can be produced.
7 REALISTIC 3D PROJECT VISUALIZATION

HERA can export key variables that can be used by AutoDesk software to produce 3D models of any engineering layout from the simulations. For this, use the Engineering tool in an existing site and select Export REVIT CSV.

The available structures to be modeled in REVIT are presented in the sequence.

1) Dams

- Concrete dam
- Rockfill dam with clay core
- Earthfill dam

2) Concrete walls

- Dividing wall
- Transition wall
- Retaining wall for rockfill dam
- Retaining wall for earthfill dam

3) Water intake with penstock branch
4) Powerhouses with assembly area

Bulb turbine (with attached intake)  Vertical Francis turbine and water intake

Other turbines not shown include concrete Kaplan with attached intake, steel Kaplan, Horizontal Francis, Horizontal and Vertical Pelton.

5) Spillways

Controlled spillway with stilling basin  Controlled spillway with ski jump  Free spillway with dissipation basin

The dimensions of the structures calculated by HERA’s engineering module are passed on to the shown objects defined in the Revit library. After their individual modeling in REVIT, the structures are automatically joined by Dynamo - a programming environment of AutoDESK, designed to build selected engineering layout on a flat surface.

With Infraworks it is possible to offer a complete visualization of the layout in the terrain, including its reservoir, as illustrated in the exhibited sequence of the next page.
The figure illustrates a hydropower project designed with HERA and exported to Auto Desk Infracworks for visualization.
ANNEX A – Engineering module plugin

Engineering Dimensioning Module Architecture

This annex details the Excel files of HERA’s engineering module. All spreadsheets are editable. However, inputs and output, shortly identified as "io" in the cells of the tabs cannot be altered. Structural design and quantity calculation tabs can be modified, by engineers specialized in designing hydroelectric plants. Basic cost data must be consistent with the reality of the case study. Verify this before starting your study. Notably the civil unit prices and the conversion rates for equipment costs.

Description of Excel files for structure dimensioning

<table>
<thead>
<tr>
<th>File (.xls)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hera_dictionary</td>
<td>Dictionary of HERA variables</td>
</tr>
<tr>
<td>hera_dams</td>
<td>Sizing of various types of dams</td>
</tr>
<tr>
<td>hera_diversion</td>
<td>Sizing of various types of river diversion</td>
</tr>
<tr>
<td>hera_spillway</td>
<td>Sizing of various types of spillways</td>
</tr>
<tr>
<td>hera_bulb</td>
<td>Sizing of compact headrace circuit with Bulb turbine</td>
</tr>
<tr>
<td>hera_kc</td>
<td>Sizing of compact headrace circuit with concrete Kaplan</td>
</tr>
<tr>
<td>hera_penstock_ka</td>
<td>Sizing of short headrace circuit with conduits and steel Kaplan</td>
</tr>
<tr>
<td>hera_penstock_fy</td>
<td>Sizing of short headrace circuit, ducts, and vertical Francis</td>
</tr>
<tr>
<td>hera_penstock_fh</td>
<td>Sizing of short headrace circuit, ducts, and horizontal Francis</td>
</tr>
<tr>
<td>hera_tunnel_p</td>
<td>Sizing of long headrace circuit in tunnel and Pelton</td>
</tr>
<tr>
<td>hera_tunnel_fy</td>
<td>Sizing of long headrace circuit in tunnel and vertical Francis</td>
</tr>
<tr>
<td>hera_tunnel_fh</td>
<td>Sizing of long headrace circuit in tunnel and horizontal Francis</td>
</tr>
<tr>
<td>hera_channel_ka</td>
<td>Sizing of long headrace circuit in channel and Kaplan steel turbine</td>
</tr>
<tr>
<td>hera_channel_fy</td>
<td>Sizing of long headrace circuit in channel and vertical Francis</td>
</tr>
<tr>
<td>hera_channel_fh</td>
<td>Sizing of long headrace circuit in channel and horizontal Francis</td>
</tr>
<tr>
<td>hera_quant</td>
<td>Auxiliary spreadsheet for volume calculation</td>
</tr>
<tr>
<td>hera_cost_factors</td>
<td>Auxiliary spreadsheet to save cost parameters defined by the user</td>
</tr>
<tr>
<td>hera_budget</td>
<td>Cost estimative spreadsheet</td>
</tr>
<tr>
<td>hera_filter</td>
<td>Filter spreadsheet for general arrangement alternatives</td>
</tr>
</tbody>
</table>

Dictionary and Variables Codification

The proposed code consists of four alphanumeric sequences (aaa_bbbb_cccc_dd) and may have prefixes corresponding to the environments where the variables are defined, such as hera or dymn. The code sequences are based on the terms used in English and are detailed as follows:

- aaa: the first sequence, always formed by letters, can be associated with main structures or themes, or also to a set of structures:

```
bdg = budget;
dam = dam;
div = diversion;
enr = energy;
fil = filter;
geo = geology;
hsv = hydraulic system;
```

- hyd = hydrology;
- lay = layout;
- oth = others;
- pwh = power house;
- res = reservoir;
- rtc = rating curve;
- spw = spillway,
• **b**bb: the second sequence, formed by four letters or numbers, is associated with substructures (TRWL, for example, are transition walls of the dam), types of structures (EART is earth dam); secondary theme (MANN is the Manning coefficient); or first substructure (for layout variables that define the distance between axes). In this case, the number zero fills voids or separate two types of structures for which the variable is valid (E0R0 indicates that the variable meets earthfill and rockfill dams).

• **ccc**c: the third sequence, also formed by four letters or numbers, is associated with substructures (DWST may correspond to a downstream cofferdam variable), equipment (SLOG is the stoplog of a given structure), excavation or construction materials (CONC is concrete), detailing the theme (RBED can refer to the thickness of the soil layer in the river bed) or second substructure (in the case of layout variables). In this case, zero has the same functions as described above.

• **dd**: the fourth sequence, formed by one or two letters, is associated with this type of variable (dimensions, values, etc.).

<table>
<thead>
<tr>
<th>c = cartesian coordinate</th>
<th>n = quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>ct = cost</td>
<td>p = capacity</td>
</tr>
<tr>
<td>d = diameter</td>
<td>pc = percentage²</td>
</tr>
<tr>
<td>dl = dimensional variable</td>
<td>q = flow rate</td>
</tr>
<tr>
<td>dt = distance¹</td>
<td>r = radius</td>
</tr>
<tr>
<td>el = elevation</td>
<td>t = ton</td>
</tr>
<tr>
<td>h = height</td>
<td>th = thickness</td>
</tr>
<tr>
<td>i = slope</td>
<td>v = dimensionless variable</td>
</tr>
<tr>
<td>k = coefficient</td>
<td>w = width or orthogonal dimension to flow</td>
</tr>
<tr>
<td>l = length or dimension in the direction of flow</td>
<td>wl = water level</td>
</tr>
<tr>
<td>m² = area in square meter</td>
<td>x = alphanumeric variable³</td>
</tr>
<tr>
<td>m³ = volume in cubic meter</td>
<td></td>
</tr>
</tbody>
</table>

Notes: 1 – used in layout variables; 2 – the setting of the value is in decimal form; 3 – also applied for layout.

Variable dictionary tabs are separated by their source environment (Excel, HERA, or Dynamo files, which is the REVIT programming environment).

**hera_diccionary.xls**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>excel</td>
<td>input (in) and output (out) variables of spreadsheets</td>
</tr>
<tr>
<td>hera</td>
<td>variables defined in Hera’s environment</td>
</tr>
<tr>
<td>dynamo</td>
<td>variables defined in Dynamo’s environment</td>
</tr>
</tbody>
</table>

**Structures dimensioning**

The functions of each of the engineering module plug-in spreadsheet tabs are detailed below.

**hera_dams.xls**

<table>
<thead>
<tr>
<th>Type</th>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concrete</td>
<td>iodam1</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td></td>
<td>dam1concrete</td>
<td>concrete dam sizing sheet</td>
</tr>
<tr>
<td>Earthfill</td>
<td>iodam2</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td></td>
<td>dam1earthfill</td>
<td>earthfill dam sizing sheet</td>
</tr>
<tr>
<td></td>
<td>trwalls2</td>
<td>transition wall sizing sheet</td>
</tr>
<tr>
<td>Rockfill</td>
<td>iodam3</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td></td>
<td>dam1rockfill</td>
<td>rockfill dam sizing sheet</td>
</tr>
<tr>
<td></td>
<td>trwalls3</td>
<td>transition wall sizing sheet</td>
</tr>
</tbody>
</table>
### hera_diversion.xls

<table>
<thead>
<tr>
<th>Type</th>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diversion by Tunnel</td>
<td>iodiv1</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td></td>
<td>div1tunnel</td>
<td>diversion by tunnel sizing sheet</td>
</tr>
<tr>
<td></td>
<td>cofferd1</td>
<td>2nd phase cofferdams sizing sheet</td>
</tr>
<tr>
<td>Diversion by Gallery</td>
<td>iodiv2</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td></td>
<td>div2gallery</td>
<td>diversion by gallery sizing sheet</td>
</tr>
<tr>
<td></td>
<td>cofferd2</td>
<td>2nd phase cofferdams sizing sheet</td>
</tr>
<tr>
<td>Diversion by the Riverbed with Sluiceways</td>
<td>iodiv3</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td></td>
<td>div3channel</td>
<td>diversion by natural channel in riverbed sizing sheet</td>
</tr>
<tr>
<td></td>
<td>div3sphosb</td>
<td>spillway with sluiceways sizing sheet</td>
</tr>
<tr>
<td></td>
<td>cofferd3</td>
<td>2nd phase cofferdams sizing sheet</td>
</tr>
<tr>
<td>Diversion by the Riverbed without Sluiceways</td>
<td>iodiv4</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td></td>
<td>div4channel</td>
<td>diversion by natural channel in riverbed sizing sheet</td>
</tr>
<tr>
<td></td>
<td>cofferd4</td>
<td>2nd phase cofferdams sizing sheet</td>
</tr>
</tbody>
</table>

### hera_spillway.xls

<table>
<thead>
<tr>
<th>Type</th>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spillway (all)</td>
<td>iogeom</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td></td>
<td>sp0geom</td>
<td>spillways’ oggee sizing sheet</td>
</tr>
<tr>
<td>Spillway with dissipation basin</td>
<td>iosb</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td></td>
<td>sp0sb</td>
<td>dissipation basin sizing sheet</td>
</tr>
<tr>
<td>Controlled spillway (dissipation basin)</td>
<td>iosp1</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td></td>
<td>sp1ghosb</td>
<td>controlled spillway with dissipation basin sizing sheet</td>
</tr>
<tr>
<td>Controlled spillway with ski jump</td>
<td>iosp2</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td>Chute controlled spillway (ski jump)</td>
<td>iosp3</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td></td>
<td>sp3ghosj</td>
<td>chute controlled spillway with ski jump sizing sheet</td>
</tr>
<tr>
<td>Free spillway with dissipation basin</td>
<td>iosp4</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td></td>
<td>sp4uhosb</td>
<td>free spillway with dissipation basin sizing sheet</td>
</tr>
</tbody>
</table>

### hera_bulb.xls

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>iohsbl</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td>hsblintake</td>
<td>water intake sizing sheet</td>
</tr>
<tr>
<td>hsblphouse</td>
<td>powerhouse sizing sheet</td>
</tr>
<tr>
<td>hsbltailrace</td>
<td>tailrace sizing sheet</td>
</tr>
</tbody>
</table>

### hera_kc.xls

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>iohskc1</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td>hskclintake</td>
<td>water intake dimensioning spreadsheet</td>
</tr>
<tr>
<td>hskclphouse</td>
<td>powerhouse dimensioning spreadsheet</td>
</tr>
<tr>
<td>hskcltailrace</td>
<td>tailrace dimensioning spreadsheet</td>
</tr>
</tbody>
</table>
### hera_penstock_ka.xls

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>iohska1</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td>hsk1 intake</td>
<td>water intake dimensioning spreadsheet</td>
</tr>
<tr>
<td>hsk1 penstock</td>
<td>penstock dimensioning spreadsheet</td>
</tr>
<tr>
<td>hsk1 powerhouse</td>
<td>powerhouse dimensioning spreadsheet</td>
</tr>
<tr>
<td>hsk1 tailrace</td>
<td>tailrace dimensioning spreadsheet</td>
</tr>
</tbody>
</table>

### hera_penstock_fv.xls

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>iohsfv1</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td>hsfv1 intake</td>
<td>water intake dimensioning spreadsheet</td>
</tr>
<tr>
<td>hsfv1 penstock</td>
<td>penstock dimensioning spreadsheet</td>
</tr>
<tr>
<td>hsfv1 powerhouse</td>
<td>powerhouse dimensioning spreadsheet</td>
</tr>
<tr>
<td>hsfv1 tailrace</td>
<td>tailrace dimensioning spreadsheet</td>
</tr>
</tbody>
</table>

### hera_penstock_fh.xls

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>iohsfh1</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td>hsf1 intake</td>
<td>water intake dimensioning spreadsheet</td>
</tr>
<tr>
<td>hsf1 penstock</td>
<td>penstock dimensioning spreadsheet</td>
</tr>
<tr>
<td>hsf1 powerhouse</td>
<td>powerhouse dimensioning spreadsheet</td>
</tr>
<tr>
<td>hsf1 tailrace</td>
<td>tailrace dimensioning spreadsheet</td>
</tr>
</tbody>
</table>

### hera_tunnel_fv.xls

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>iohsfv2</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td>hsf2 route</td>
<td>spreadsheet for generating circuit parameters</td>
</tr>
<tr>
<td>hsf2 intake</td>
<td>channel's water intake dimensioning spreadsheet</td>
</tr>
<tr>
<td>hsf2 tunnel</td>
<td>headrace tunnel dimensioning spreadsheet</td>
</tr>
<tr>
<td>hsf2 tank</td>
<td>surge tank dimensioning spreadsheet</td>
</tr>
<tr>
<td>hsf2 penstock</td>
<td>penstock dimensioning spreadsheet</td>
</tr>
<tr>
<td>hsf2 powerhouse</td>
<td>powerhouse dimensioning spreadsheet</td>
</tr>
<tr>
<td>hsf2 tailrace</td>
<td>tailrace dimensioning spreadsheet</td>
</tr>
</tbody>
</table>

### hera_tunnel_fh.xls

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>iohsfh2</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td>hsfh route</td>
<td>spreadsheet for generating circuit parameters</td>
</tr>
<tr>
<td>hsfh intake</td>
<td>channel's water intake dimensioning spreadsheet</td>
</tr>
<tr>
<td>hsfh tunnel</td>
<td>headrace tunnel dimensioning spreadsheet</td>
</tr>
<tr>
<td>hsfh tank</td>
<td>surge tank dimensioning spreadsheet</td>
</tr>
<tr>
<td>hsfh penstock</td>
<td>penstock dimensioning spreadsheet</td>
</tr>
<tr>
<td>hsfh powerhouse</td>
<td>powerhouse dimensioning spreadsheet</td>
</tr>
<tr>
<td>hsfh tailrace</td>
<td>tailrace dimensioning spreadsheet</td>
</tr>
</tbody>
</table>
**Engineering solutions**

The concept of general engineering arrangement in HERA is divided in “templates”, which consist of the structures that make up a given engineering solution, and “layouts” which define the relative position of these structures along the dam axis. The next two tables show there are 69 templates. Template 1 (first column) has a Bulb turbine with a compact hydraulic system. The river is diverted with a tunnel, the spillway is a controlled chute and it has a rockfill dam.
with a transition wall. Currently has 174 engineering solutions, with 51 templates having 2 layouts and 18 templates having 4 layouts ($51 \times 2 + 18 \times 4 = 174$).

### Templates

| Template Id → | 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 | 18 | 19 | 20 | 21 | 22 | 23 | 24 | 25 | 26 | 27 | 28 | 29 | 30 | 31 | 32 | 33 | 34 |
|---------------|---|---|---|---|---|---|---|---|---|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|
| Bulb Kaplan Concrete Kaplan Steel Vertical Francis Horizontal Francis Pelton |
| Hydraulics Penstock Tunnel Headrace channel |
| Diversion | Two-step, on the riverbed, without sluiceway | Two-step, on the riverbed, with sluiceway | Tunnel | Gallery |
| Spillway | Controlled with Still Basin | Controlled with Ski Jump | Controlled Chute | Uncontrolled with Still Basin |
| Dam | Concrete | Earthfill | Rockfill | Transition wall |

| Template Id → | 35 | 36 | 37 | 38 | 39 | 40 | 41 | 42 | 43 | 44 | 45 | 46 | 47 | 48 | 49 | 50 | 51 | 52 | 53 | 54 | 55 | 56 | 57 | 58 | 59 | 60 | 61 | 62 | 63 | 64 | 65 | 66 | 67 | 68 | 69 |
|---------------|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|
| Bulb Kaplan Concrete Kaplan Steel Vertical Francis Horizontal Francis Pelton |
| Hydraulics Penstock Tunnel Headrace channel |
| Diversion | Two-step, on the riverbed, without sluiceway | Two-step, on the riverbed, with sluiceway | Tunnel | Gallery |
| Spillway | Controlled with Still Basin | Controlled with Ski Jump | Controlled Chute | Uncontrolled with Still Basin |
| Dam | Concrete | Earthfill | Rockfill | Transition wall |
### Layouts

| Layout Id | 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 | 18 | 19 | 20 | 21 | 22 | 23 | 24 | 25 | 26 | 27 | 28 | 29 | 30 | 31 | 32 | 33 | 34 |
|-----------|---|---|---|---|---|---|---|---|---|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|
| Spillway & intake on the riverbed | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | |
| Spillway on the right side of the riverbed | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | |
| Water intake on the right side of the spillway | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | |
| Spillway on the left side of the riverbed | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | |
| Water intake on the left side of the spillway | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | |
| Spillway on the right bank | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | |
| Water intake on the left bank | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | |
| Spillway on the left bank | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | |
| Water intake on the right bank | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | |
| Spillway on the right bank | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | |
| Water intake on the right bank | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | |
| Water intake on the left bank | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | |
| Water intake on the right bank | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | |
| Water intake on the left bank | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | |
| Spillway on the center of the riverbed | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | |
| Water intake on the left bank | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | |
| Spillway on the center of the riverbed | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | |
| Water intake on the right bank | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | | |

### Examples of templates and layouts encoding

**Ex1:** The arrangement has Bulb turbines (PhBulb) in compact addition circuit (HsComp), concrete dam (DmConc), controlled spillway with dissipation basin (SpCbas) and diversion through the riverbed without sluiceways (DvRbed).

**Ex2:** The layout is a foot of the dam with a diversion through the riverbed and longitudinal cofferdam (FrBedLcfd), with spillway positioned in the riverbed. Intake is on the left (SpRbed InLspw).
Filters

The implementation of filters in a specific spreadsheet tries to avoid the unnecessary alternatives simulation of general arrangement, using the basic data available at the beginning of each workflow (such as installed capacity, gross head resulting from the dam, gross head resulting from long circuit diversion, among others). From criteria that can be defined, the output variables return FALSE or TRUE values for each type of structure.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>iофilter</td>
<td>input (in) and output (out) variables tab</td>
</tr>
</tbody>
</table>

Quantities Calculation

The calculations performed in the file "hera_quant.xls" cover structures that cannot be calculated by numerical integration, except for the concrete of the different types of powerhouses, whose volume is calculated in their respective dimensioning spreadsheets, resulting in a value associated with an output variable common to all hydraulic system files.

This file also works like a spreadsheet that consolidates the calculations of civil volumes, in specific cases, composing portions that are calculated in HERA's environment by numerical integration with those calculated in the spreadsheet itself, and generally defines the specific variables to the file that generates the budgets ("hera_budget.xls").

Tabs's description of the auxiliary file for volumes calculation (hera_quant.xls)

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>iоquant</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td>dam_eart</td>
<td>calculation of complementary volumes for the earthfill dam; filters, protection of upstream and downstream slopes</td>
</tr>
<tr>
<td>div_tund</td>
<td>calculation of concrete volumes of diversion tunnels: water intake, bulkhead, and lining</td>
</tr>
<tr>
<td>div_gall</td>
<td>calculation of concrete volumes of diversion galleries (including water intake and bulkhead) and complement of rock excavation at the foundation</td>
</tr>
<tr>
<td>div_slui</td>
<td>calculation of concrete volumes of sluiceways (including water intake and bulkhead) and complement of rock excavation at the foundation</td>
</tr>
<tr>
<td>hsy_intk</td>
<td>calculation of concrete volumes of water intake up to 2,5m elevation below the sill (below this elevation, HERA calculates)</td>
</tr>
<tr>
<td>hsy_tunn</td>
<td>calculation of hydraulic system tunnel volumes: underground excavation, conventional and projected concrete, lining</td>
</tr>
<tr>
<td>hsy_stnk</td>
<td>calculation of the surge tank: common and open pit rock excavations, underground excavation, conventional concrete</td>
</tr>
<tr>
<td>hsy_chnl</td>
<td>calculation of hydraulic system volumes: common and open pit rock excavations, conventional concrete</td>
</tr>
<tr>
<td>hsy_fbay</td>
<td>calculation of forebay volumes including the intake common and open pit rock excavations, conventional concrete</td>
</tr>
<tr>
<td>hsy_pstk</td>
<td>calculation of concrete volumes of penstock blocks, as well as common and rock excavations</td>
</tr>
<tr>
<td>spw_strc</td>
<td>calculation of spillway complementary concrete volumes (pillars and walls, since the ogee is calculated by HERA)</td>
</tr>
</tbody>
</table>
**Costs Estimate**

The budgeting file collects as input variables the following information:

- Unit prices, percentages and conversion rates defined in HERA’s interface by the users and saved in “hera_cost_factors.xls”.
- Volumes of civil works obtained as explained above and equipment costs calculated by the spreadsheets of the Brazilian Inventory Manual.
- Environmental metrics from the user interface.

In the end it generates total costs as output variables.

**hera_cost_factors.xls**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>io_up</td>
<td>unit prices for civil works</td>
</tr>
<tr>
<td>io_env</td>
<td>unit prices for the environmental account</td>
</tr>
<tr>
<td>io_perc</td>
<td>percentages used to estimate other costs</td>
</tr>
<tr>
<td>io_conv</td>
<td>conversion rates for equipment costs</td>
</tr>
</tbody>
</table>

**hera_budget.xls**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>iocosts</td>
<td>input (in) and output (out) variables tab</td>
</tr>
<tr>
<td>unit_prices</td>
<td>basic unit prices definition</td>
</tr>
<tr>
<td>summary</td>
<td>tables with summaries of quantities and costs</td>
</tr>
<tr>
<td>balance</td>
<td>simplified materials balance (cut and fill volumes)</td>
</tr>
<tr>
<td>budget</td>
<td>Budget following Eletrobras standard</td>
</tr>
</tbody>
</table>